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How to Download Data

Data Download Directory

The data download tool consists of an index of downloadable data files. The files are organized
by state, level (school, school district, or state) and by year. In large states, school files are further
subdivided by alphabetic grouping, based on the school name. School names beginning with
numbers are included in the first alphabetic grouping.

A single directory file is provided for each level within each state. The directory file contains
descriptive information for all the entities in a given state at a particular level for which data have
been provided (i.e. a school level directory file for Delaware would include descriptive information
for all the schools in Delaware for which data are available).

Downloading
To download a file, click on the file name and choose a location to save the file to your computer.

File Size

The downloaded files are compressed and will need to be unzipped by a standard compression
utility such as WinZip. The Data Download files may be quite large. For example, a compressed
file may be 6 MB and an uncompressed file may be over 100 MB.

File Format
The files are in a flat, pipe-delimited format. Figure 1 shows a sample of the data.

Figure 1. Sample of Data File Format

1000080 | appoquinimink School District|2006]Community Demographics|Dpistrict median AHE (&) 38
bution|1l4.301000080| Appogquinimink school District|Z006|Community Demographics|Household Incd
School District|2008|Community Demographics|Population Total|33, 33701000080 Appoguinimink s:
math Hizpanic pProficiency (y/n)|rvesilo00080|Appoguinimink school District|2006|NCLE|E]ement:
s01000080 | Appogquinimink School District|2006|MCLE|Elementary AYP Read Asian Participation
LE|ETementary AvP Read Matam Participation (yfnjln.a.ulOODOSDIApquuinimink school District
istrict|2006{NCLB|High AYP Math BTacE Participation (/)| ves0lo00080|Appoguinimink School

CL|2006|NCLE|High AYP math StudwDis Proficiency Cy/n)|n.a. 01000080 appoguinimink School Dist
pogquinimink School District|2006|NCLE|High AYP Reading Hispanic Participation (ﬁfﬂjln.a.nlﬂt
al Cy/n)|ves0lo00080|Appoquinimink School District|2006|NCLE|Met AYP CO_High schools Total o
le a¥p Math Econbis Participation Oy n)|vesdlo000B0|appogquinimink School District|2006|NCLE
T|2006|NCLE|[MiddTe avp Math white proficiency Cy/n)|vesplooo080|appoguinimink school Distris
iency (y/n)|vesilo00080 | Appoguinimink School District|2006|NCLE|Midd]le AvP Reading LEP Parti
Dis CCD (%) ]|13. 901000080 Appogquinimink School District|2006|sS&F Ratios|math Proficiency All
P Ratios|RAMP Score (%)|83.701000080|Appogquinimink School District|2006|s&F Ratios|RaMP Math
0l District|2006|S&P Ratios|Ramp Scores — Female| 84, 701000080 | appogquinimink School District
Qo080 | appoquinimink School District|2008]|S&F Ratios|Reading Proficiency Female (%)|8%.70100¢
adcount Grade 1|60001000080|Appogquinimink school District|Z2006|schoo]l Environment |Headcount
adcount Grade 3 / Headcount Totall|s. 201000080 Appoquinimink School District|2006|school Enw
nment | Headcount Grade 9|633u1000080|ApquuinimﬁnE school District|zZo06]|school Ervironment | He
| 72.401000080| appoguinimink School District|2006]|student Performance|state Test Math Grade -
ack Pass Advanced ?%)In.a.nlDOODBOIA pogquinimink School District|2006]student Performance| st
Grade 10 EconDis Pass Below Basic (%gln.a.DIOOOOBOIAp ogquinimink =chool District|2006|studes
ce|state Test Math Grade 10 Female Pass Proficient (%gln.a.nlOODOSDlApquuinimink School b
rict|2006|student Performance|sState Test Math Grade 10 LEP Pass (%) |n.a. 01000080 appogquinim]
t Performance|state Test Math Grade 10 Male Pass Basic (¥)|n.a.0lo00o80|Appogquinimink schoo]
|2006] student Performance|state Test Math Grade 10 Migrant Pass LS (%)|n.a. 01000080 Appoguiy
ol pistrict|2006|student Performance|state Test Math Grade 10 Matam Tested () |n.a. 01000080
chool District]|2006|student Performance|state Test Math Grade 10 studwDis Pass Basic CX)|n.:
1000080 | appoquinimink School District]|2006|student Performance|sState Test Math Grade 10 Tot:
n.a. 01000080 aAppogquinimink School District|2006]|student Performance|state Test Math Grade 11
|78, 901000080 | Appogquinimink School District|2006|student Performance|state Test Math Grade
217, 201000080 Appoquinimink School District|2006]|student Performance|state Test Math Grade
LS (%)]12.301000080 | Appogquinimink school District|2006]student Performance|state Test Math o
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Figure 2 shows a sample of the data imported into a spreadsheet.

Figure 2. Sample of Data imported into a Spreadsheet

STHUOEL Accomack County Fublic schools U student Hertormance otate [est Fead Ho Cohort studwlis Tested (3 o
5100060  Accomack County Public Schools 2006 | Student Perdormance State Test Read HS Cohort Total Participation (%) 95.4
5100060  Accomack County Public Schools 2006 | Student Perdormance State Test Read HS Cohort Total Pass (%) 7B.7
5100060  Accomack County Public Schools 2006 | Student Perdformance State Test Read HS Cohort Total Pass Basic (%) 223
5100060  Accomack County Public Schools 2006 | Student Performance State Test Read HS Cohort Total Pass Below Basic (%) 233
5100060  Accomack County Public Schools 2006 | Student Performance State Test Read HS Cohort Total Pass Proficient (%) 24.4
5100060  Accomack County Public Schools 2006 Student Perfarmance State Test Read HS Cohort Total Tested (#) 435
5100060  Accormack County Public Schools 2006 Student Perfarmance State Test Read HS Cohort White Participation (%) 946
5100060  Accomack County Public Schools 2006 Student Perfarmance State Test Read HS Cohort White Pass (%) 85.4
5100060  Accomack County Public Schools 2006 Student Perfarmance State Test Read HS Cohort White Pass Basic (%) 481
5100060  Accomack County Public Schools 2006 Student Perfarmance State Test Read HS Cohont White Pass Below Basic (%) 146
5100060  Accomack County Public Schools 2006 Student Perfarmance State Test Read HS Cohont White Pass Proficient (%) 373
5100060  Accomack County Public Schools 2006 Student Perfarmance State Test Read HS Cohont White Tested [#) 212
5100090 | Albermarle County Public Schools 2006 Community Demographics  District Median Age (# 36
5100090 | Albemarle County Public Schools 2006 Community Demographics Education Adults with at Least a Bachelors Degree / Adults (%) 51.4
sn00anAlbernarde County Piblic Schonl 200F Comrmunity Demonranhics  Education Adilts with at Least g Hink School Dinlomrs SAdnlts 1o =

As shown above, the data files contain the following:

Column 1: Location Code

Column 2: Name
Column 3: Year
Column 4: Category

Column 5: Variable Name

Column 6: Data

Location Code is the school, district or state code used by NCES. Where NCES IDs are not
available, state assigned identifiers are used. NCES codes may contain leading zeros. Import the
data in text format to avoid losing leading zeros.

Name is the name of the education entity.

Year reflects the end of the school year for which data are provided. For example, 2006 reflects
data from the 2005-06 school year.

Cateqory reflects the category under which the data can be found on the SchoolDataDirect

website.

Variable Name provides a description of the data. For example, State Test Read HS Male Total
Pass (%) is the variable name for the passing rate for males on the state reading test.

State tests use the following naming convention:
Data Type > Subject > Grade or School Level > Subgroup > Measure

For example:

State Test Read Grade 3 White Proficiency (%)

The variables available will vary from state to state depending on the data elements that were

provided by the state department of education. If a variable name identified in one state does not
appear in another state, it is because that element was not provided by the second state. For
example, “State Test Read Grade 9 Total Pass (%)” will appear in a state that tests grade 9, but
will not appear for a state that does not test grade 9.
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The format for the data files is consistent for school, district and state level information. In the

directory files, descriptive information varies for the school, district and state levels, so these files

include column headers in the data, as shown in Figure 3.

Figure 3. Sample of Directory File Format

A | B | ¢ | D | E | F | G H
1 |location_name location_code  address  |city_name zip_code county_name phaone district_nay
2 |Acadery Of Dover Charter Schoal 100001700144 104 Saulst Dover 19904 Kent (30267 4-0684  Academy (
3 |Albert H. Jones Elementary School 100020000229 Christiana Mewark 19702 Mew Castle  (3023454-2131  Christina 5
4 |Alexis |. Dupont High School 100130000276 50 Hillside Greerwille 19807 Mew Castle (302651-2626 Red Clay O
5 |Alexis | Dupaont Middle School 100130000272 3130 Kenn Greenille 19807 | Mew Castle  (3029651-2650 Red Clay C
B |Allen Frear Elementary Schoal 100018000038 233 SorghiCamden-Wy 19934 Kent (I0BE7-3279  Caesar Roy
7 |Alternative Center For Education (Ace) 100023000061 1701 SoutlSt. George. 19733 Mew Castle  (302)323-2700  Colonial Sc
8 |Alternative Programs 100020000010 1800 ProsWilmington 19805 Mew Castle  (302)428-3146  Christina 5
8 |Anna P. Maote Elementary School 100130000254 2110 EdweWilmington 19808 New Castle  (302)992-5565 Red Clay C
10 | Appoguinirink Early Childhood Center 100008000103 502 South Middletown 19709 Mew Castle  (302)376-2400  Appoguinin
11 |Austin 0. Baltz Elementary School 100130000264 1500 SprudWilmington 19805 Mew Castle  (302)992-5560 Red Clay C
12 |Bancroft Elementary School 100020000233 700 Morth Wilmington 19801 New Castle  (302428-4102  Christina 5
13 |Bayard Elementary School 100020000232 200 South Wilmington 19805 Mew Castle  (3023428-4118  Christina 5
14 |Beacon Middle School 100017000037 19453 Johi Lewes 19953 Sussex (I02)B45-62685  Cape Henly
15 |Benjamin Banneker Elementary School | 100108000107 443 Morth  Milford 19963 Kent (30)422-1630  Milfard Sch
16 |Blades Elerentary 100153000020 200 South Seaford 19973 Sussex (302623-7194  Seaford St
17 |Booker T. Washington Elerentary Scho 100012000057 901 Forest Dover 19904 Kent (A0672-1900  Capital Sch
18 |Brandywine High Schoal 100124000242 1400 FoulkWilmington 19803 Mew Castle  (302)479-1600  Brandywine

Opening the Files

Some of the files contain too many records to be opened fully in spreadsheet applications, so it is
highly recommended that you use statistical analysis software (such as SAS) to work with
the files, particularly if you are working with school or school district data. If you are interested in
downloading data for a small number of schools or districts (up to 100), use the Create Your Own

Table tool, also available on SchoolDataDirect.org.

If you are working with a smaller file (such as a state level file) and you would like to use
Microsoft Excel, you can follow the process outlined below to open the file.

Microsoft Excel Instructions

1. Uncompress the downloaded file using a standard compression utility such as
WinZip and save the uncompressed file someplace you will remember.

Launch Excel.

Using the Excel menus, select File > Open.

2
3.
4. Inthe “Files of Type” box, select “Text Files” (see below).
3

XML Files

all Microsoft Office Excel Files
Microsoft Office Excel Files
all web Pages

File nare: I

ork. _
5 Files of bype: | Text Files [ Cancel

all Files ”

5. Locate the uncompressed data file, select it and click open. This will launch the

Text Import Wizard.
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6. Select “Delimited”.

Text Import Wizard - Step 1 of 3

The Text Wizard has determined that wour data is Fixed Width.

IF this is correct, choose Mext, or choose the data tvpe that best describes vour data.
Qriginal data twpe
Choose the file type that best describes vour data:

) - Characters such as commas or babs separate each field.
) Fixed width - Fields are aligned in columns with spaces between each Ffield,
Skart impork ak rowe: File: arigin: 437 : OEM United States b

Preview of file C:\Documents and Settingstfowlkesel\DeskioptDE_Di. . A\DE_Dis_2006,txt,

LOCOOE0 | Appoquinimink School District| 2006 | Analytics|Enrollment f
LOCOO20 | Appoqaininink School District| 2006 |Analytics|Enrollment
LOO0O20 | Appogainimink School District | 2006 |Analytics|Enrol lment
LOO0Os0 | Appogainimink School District | Z006|Analytics|PCI State
LOCOO20 | Appogquinimnink School District|EZ00&|Analytics|FPCI State o
| >

[ wext> |[ Emish |

[ |m|ﬂ|w|N|H

7. Click Next to proceed.
8. Set the Delimiters parameter to “Other” and then type in a pipe character. Hold

down the Shift key and the Backslash key (above the Enter key) to type the pipe
character.

Text Import Wizard - Step 2 of 3

This screen lets you set the delimiters wour data contains, You can see
hiow wour text is affected in the preview below,

Delirmiters
[J1ab [] semicalon [] comma

[Nspace |[+] other: EI Text gualifier:

[] Treat consecutive delimitars as one

Dakta prewview

PO00020 Appoquininink School District EFO0G Phnalytics Enrollment E f
LOO00s80 Approcguininink School District EFOO06 Pnalytics Enrcllment L
LOO00s0 Appogquininink School Discrict [EOOE Pnalytics Enrcllment =
RO0O0E20 Appogquininink School District EO00& Phnalytics [PCI Stcate Te
PO0O0E0 Appoquinimink School District FO0& Phnalytics [PCI Scate Te

< | >

Cancel ][ = Back ]| Mext = H Finish

9. Click Next.
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10. Set the Column data format to “Text”

Text Import Wizard - Step 3 of 3

This screen lets wou select each column and set Colurnn daka Formnak
the Diata Format, ) General

‘General’ converks numeric values to numbers, date
walues ko dates, and all remaining walues bo bext,
! d () Date;  |MDY

s

() Do not import column (skip)

Daka preview

snergl CeperGeneral Ceneral

ippoquinimink School District FOO0& Phnalyktics Enrollment E
ippoquinimink School District FOO0& Phnalytics Enrollment L
ippoquinimink School District FOO0& Phnalytbics Enrollment 3
ippoquinimink School District FO0& Phnalyktics PCI State Te
ippoquinimink School District FO0& Phnalyktics PCI State Te

Cancel ” < Back

11. Click Finish.

Using Pivot Table to Work with a Small Amount of Data

If you are working with a small amount of data in Excel (fewer than 256 rows of data) and would
like to view the data with the variables across the top of your spreadsheet and the locations down
the side, you can use the following procedures to pivot the data.

Pivot table is a feature that enables one to summarize large amounts of data. It can be used to
rotate the layout of downloaded data files.
1. You must have fewer than 256 rows of data to create a pivot table. Delete any data
elements you are not interested in, or cut and paste elements you are interested in to
a new worksheet so that you end up with a worksheet containing fewer than 256
rows. In the example illustrated below, only Reading Proficiency rows are included.

A B lc[ o ] E | F 6 | H &«

| 1 1000080 Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency AsianfPl (%) 90.3
| 2 1000080 | Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Black (%) 78
| 3 1000080 | Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency EcanDis (%) 76.1
| 4 1000080  Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Female (%) g9.7
| 5 1000080  Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Hispanic (%) 845
| B |[1000080  Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Male (%) 845
| 7 |1000080  Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Mon-EconDis (%) 888
| 8 |1000080  Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Mon-LEP (%) 873
| 9 1000080  Appoguinimink School District | 2008 Analytice RaMP Reading Proficiency Non-Migrant (%) 873
| 10 /1000080 Appoguinimink School District | 2006 Analytice RaMP Reading Proficiency Non-StudwDis (%) 90.7
| 11 /1000080 Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency StudwDis (%) 449
| 12 11000080 Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Total (%) 873
| 13 11000080 Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency White (%) 898
| 1411001240 Brandywine School District 2006 | Analytics RaMP Reading Proficiency Asian/Pl (%) 923
| 1611001240 Brandywine School District 2006 | Analytics RaMP Reading Proficiency Black (%) 638
| 16 11001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency EconDis (%) [=£}
| 17 /1001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Fermale (%) 83.1
| 16 /1001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Hispanic (%) 66.7
| 191001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency LEP (%) 832
| 20 11001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Male (%) 745
| 21 /1001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Mon-EconDis (%) 876
| 22 11001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Mon-LEP (%) 721
| 23 [1001240 | Brandywine School District 2006 | Analytics RaMP Reading Proficiency Non-Migrant (%) 78.7
| 24 [1001240 | Brandywine School District 2006 Analytice RaMP Reading Proficiency Non-StudwDis (%) 4.1
| 25 [1001240 | Brandywine School District 2006 Analytice RaMP Reading Proficiency StudwDis (%) 274
| 26 11001240 Brandywine School District 2006 Analytice RaMP Reading Proficiency Total (%) 787
| 27 11001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency White (%) 896
| 28 11000180 | Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Asian/Pl (%) 932
| 29 11000180 | Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Black (%) 793
| 30 11000180 | Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency EcanDis (%) 79
| 31 /1000180 | Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Female (%) 898
| 32 11000180 | Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Hispanic (%) G88.8
| 33 11000180 | Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Male (%) 648
| 34 |1000180 | Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Non-EcanDis (%) a0 EI _l 2
\4”4«Tn»;r\nDE:ﬁi's:zu’aﬁlf BT SR PO B T BT WOV SE SRS YIS =11 W‘\< o =
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2. Highlight the top row in your worksheet and use the Excel menus to select Insert >

Rows.
) Fle  Edt Yiew ert | Format  Tools  Data  Window Help  Adobe PDF Type aquestion Forhelp = o B X
A= N ) SS9 -c R E-HEA MG e fiv o B2 S==4) %6
Al Columns
A Worksheet c | b | E [ F 6 [ 1 =
1000080 Appog @ Chart PO0E Analytics RahdP Reading Proficiency Asian/Pl (%) 580.3
| 2 1000080 Appog| /= BODB Analytics RalP Reading Proficiency Black (%) 78
| 3 1000080 Appog| £« Function... POOE Analytice RalMP Reading Proficiency EconDis (%) 76.1
| 4 1000080 Appog Name » POOE Analytics RahdP Reading Proficiency Female (%) 89.7
| 5 1000080  Appog) _ PO0E Analytics RalMP Reading Proficiency Hispanic (%) B84.5
| 6 1000080 Appog EHm ¥ PODB Analytics RaMP Reading Proficiency Male (%) 845
| 7 1000080  Appoq| &, Hyperlink... cirbbk POOB Analytice RaMP Reading Proficiency Non-EconDis (%) 88.9
| G 1000080  Appog) v ROOE Analytics RahP Reading Proficiency Mon-LEP (%) 87.3
| 9 1000080 Appogommrescrmororster 2006 Analytics  RabP Reading Proficiency Non-Migrant (%) B7.3
| 10 1000080 Appoguinimink School District | 2008 Analytice  RabP Reading Proficiency Non-StudwDis (%) 580.7
| 11 /1000080 Appoguinimink School District | 2006 Analytics RalP Reading Proficiency StudwDis (%) 44.9
| 12 11000080 Appoguinimink School District | 2006 Analytics RahP Reading Proficiency Total (%) B7.3
| 13 1000080 Appoguinimink School District | 2008 Analytics RahP Reading Proficiency White (%) 89.9
| 14 11001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Asian/Pl (%) 923
| 1511001240 Brandywine School District 2006 Analytics RahP Reading Proficiency Black (%) B38
| 16 /1001240 Brandywine School District 2008 Analytics RabP Reading Proficiency EconDis (%) B4
| 17 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency Female (%) 83.1
| 18 /1001240 Brandywine School District 2006 Analytics RabP Reading Proficiency Hispanic (%) B6.7
| 19 /1001240 Brandywine School District 2008 Analytics RabP Reading Proficiency LEP (%) 889
| 20 /1001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Male (%) 745
| 21 11001240 Brandywine School District 2006 Analytics RabP Reading Proficiency Mon-EconDis (%) B7 6
| 2211001240 Brandywine School District 2006 Analytice RahP Reading Proficiency Non-LEP (%) 791
| 23 /1001240 Brandywine School District 2006 Analytics RahP Reading Proficiency Mon-Migrant (%) 78.7
| 24 11001240 Brandywine School District 2006 Analytics RabP Reading Proficiency Mon-StudwDis (%) B4.1
| 25 11001240 Brandywine School District 2006 Analytics RahP Reading Proficiency StudwDis (%) 274
| 26 1001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Total (%) 78.7
| 27 11001240 Brandywine School District 2006 Analytics RabP Reading Proficiency White (%) B96
| 25 /1000180  Caesar Rodney School District | 2006 Analytics RahdP Reading Proficiency Asian/PI (%) 93.2
| 29 |1000180  Caesar Rodney School District | 2006 Analytics RahP Reading Proficiency Black (%) 79.3
| 30 /1000180 Caesar Rodney Schoal District | 2006 Analytics RahdP Reading Proficiency EconDis (%) 79
| 31 /1000780  Caesar Rodney School District | 2006 Analytics RalP Reading Proficiency Female (%) 89.8
| 32 1000180 Caesar Rodney School District | 2006 Analytics RabP Reading Proficiency Hispanic (%) 898.8
| 33 11000180 Caesar Rodney Schoal District | 2006 Analytics RahdP Reading Proficiency Male (%) B4B
| 34 /1000180 Caesar Rodney School District | 2006 Analytics RahdP Reading Proficiency Non-EcanDis (%) 50.6 =
I:r‘«.:nr;;n\nDE:lj '_7203677 e e = e -
3. Create headers for the data that will help you identify the type of data in each
column. Suggested headers are illustrated below.
A B [c[ D | E F_ | o B
Code Name Year Category Variable Data
2 1000080 | Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Asian/Pl (%) 90.3
3 1000080 | Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Black (%) 78
4 1000080  Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency EconDis (%) 761
5 (1000080 | Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Female (%) 89.7
B 1000080 | Appoguinimink School District | 2006 Analytics RaMP Reading Proficiency Hispanic (%) 54.5

4. Highlight all the data (including the headers) by clicking and dragging across the

cells.
A B |c | D E F 6 [ H &
| 1 |Code Name Year Category Variable Data
| 2 |1000080  Appoguinimink School District 2006 Analytics RahiP Reading Proficiency Asian/Pl (%) 90.3]
[ 3 |1000080  Appoquinimink School District 2008 Analytics RaMP Reading Proficiency Black (%) 78
| 4 |1000080 Appoguinimink School District 2006 Analytics RaMP Reading Proficiency EconDis (%) 76.1
|5 |1000080  Appoquinimink School District 2008 Analytics RaMP Reading Proficiency Female (%) 897
| B |1000080  Appoquinimink School District 2006 Analytics RaMP Reading Proficiency Hispanic (%) 84.5]
[ 7 |1000080  Appoquinirink School District 2008 Analytics RaMP Reading Proficiency Male (%) 845
| B |1000080  Appoquinimink School District 2006 Analytics RaMP Reading Proficiency Mon-EconDis (%) 88.9)
|9 |1000080  Appogquinimink School District 2008 Analytics RaMP Reading Froficiency Nan-LEP (%) 673
| 10 |1000080  Appoquinimink School District 2008 Analytice RaMP Reading Proficiency Mon-Migrant (%) 7.3
{11 |1000080  Appoquinimink School District 2008 Analytics RaMP Reading Froficiency Nan-StudwDis (%) 907
| 1211000080  Appoquinimink School District 2008 Analytice RaMP Reading Proficiency StudwDis (36) 449
| 13 |1000080  Appaguinimink School District 2006 Analytics RalMP Reading Proficiency Total (%) &7.3]
| 14 |1000080  Appoquinimink School District 2008 Analytics RaMP Reading Proficiency White (%) 899
| 15 1001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Asian/Pl (%) 92.3]
|16 |1001240  Brandywine School District 2008 Analytics RaMP Reading Proficiency Black (%) 638
| 17 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency EconDis (%) 64
|18 |1001240  Brandywine School District 2008 Analytics RaMP Reading Proficiency Female (%) 831
| 19 |1001240  Brandywine School District 2008 Analytics RaMP Reading Proficiency Hispanic (%) BB.7|
|20 |1001240  Brandywine School District 2006 Analytics RaMP Reading Praficiency LEP (%) 88.9
| 21 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency Male (%) 74.5]
| 22 1001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency Mon-EconDis (%) 87 5|
| 23 |1001240  Brandywine School District 2008 Analytics RaMP Reading Proficiency Mon-LEP (%) 791
24 [1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency Non-Migrant (%) 787
| 25 |1001240  Brandywine School District 2008 Analytics RaMP Reading Proficiency Mon-StudwDis (%) 84.1
| 26 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency StudwDis (%) 27 4
| 27 |1001240  Brandywine School District 2008 Analytics RaMP Reading Proficiency Total (%) 78.7]
| 28 1001240 Brandywine School District 2006 Analytics RaMP Reading Proficiency YWhite (%) 89 5|
| 29 11000180  Caesar Rodney School District 2008 Analytics RaMP Reading Proficiency Asian/Pl (%) 93.2]
| 30 1000180 Caesar Rodney School District 2006 Analytics RahiP Reading Proficiency Black (%) 79.3]
[37|1000180  Caesar Rodney School District 2008 Analytics RaMP Reading Proficiency EconDis (%) 79
| 32 |1000180  Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Female (%) 89.8]
|33 |1000180  Caesar Rodney School District 2008 Analytics RaMP Reading Proficiency Hispanic (%) 538
| 34 1000180 Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Male (%) 84.8] 2
4 r HNDE DIs 2006/ T e e L — >
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5. Using the Excel menus, select Data > PivotTable and PivotChart Report.

i Ble Edt Wew Insert  Format  Tooks | Data | Mindow  Help  Adobe PDF Type aguestionforhelp |- o & %
NEEHRG R FE 8 e Voo B = |
F185 - A& 817 Eiter 4

A B Farm... E [ F G [ H 3
| 1 |Code Name sttt Data
|2 1000080 Appoguinimink School District = ency Asian/Pl (%) an3
| 3 1000080  Appoguinimink School District] valdatian... ency Black (%) 78
| 4 1000080  Appoguinimink School District] Table... ency EconDis (%) 7B.1
| 5 |1000080  Appoguinimink School District N ency Female (%) 89.7]
| B |1000080  Appoguinimink School District eztheoke e ency Hispanic (%) 84.5]
| 7 |1000080  Appoguinimink School Distric) Consolidate. . ency Male (%) 84.5)
| & 1000080 Appoguinimink School District) Group and Outline » [ncy Non-EconDis (%) 88.9]
| 9 1000080 Appoguinimink School District] noy Mon-LEP (%) 87.3]
(10 [1000080  Appoguinimink School District| il PivotTable and PivotChart Report. lency Mon-Migrant (%) 873
| 11 [1000080  Appoguinimink School District] Impart External Data » [ency Mon-StudwDis (%) a0.7
| 12 |1000080  Appoguinimink School District] s ency StudwDis (%) 44 9)
| 15 |1000080  Appoguinimink School District] N ency Total (%) 873
|14 |1000080  Appoguinimink School District] | 2ML » lency White (%) 699
| 16 |1001240 Brandywine School D\slr!cl Refresh Data ency Asian/Pl (%) 92.3)
| 16 |1001240  Brandywine School District o ncy Black (%) 63.8]
| 17 |1001240  Brandywine School District 2008 Analytics RaMP Reading Proficiency EconDis (%) B4
| 18 |1001240  Brandywine School District 2006 Analytice RaMP Reading Proficiency Female (%) 83.1
| 19 |1001240  Brandywine School District 2008 Analytice RaMP Reading Proficiency Higpanic (%) BB.7|
| 20 |1001240  Brandywine School District 2006 Analytice RaMP Reading Proficiency LEP (%) 88.9]
| 21 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency Male (%) 74.5]
| 22 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency MNon-EconDis (%) 87 B
| 23 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency MNon-LEP (%) 791
| 24 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency Mon-Migrant (%) 787
| 25 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency Mon-StudwDis (%) 841
| 26 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency StudwDis (%) 27 .4
| 27 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency Total (%) 78.7)
| 26 |1001240  Brandywine School District 2006 Analytics RaMP Reading Proficiency White (%) 89.5]
| 29 |1000780  Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Asian/Pl (%) 93.2]
301000180 Caesar Rodney School District 2006 Analytice RaMP Reading Proficiency Black (%) 79.3]
| 31 [1000180  Caesar Rodney School District 2008 Analytice RaMP Reading Proficiency EconDis (%) 79
| 32 |1000180  Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Female (%) 89.8]
| 33 |1000180  Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Hispanic (%) 88.8]
| 34 |1000180  Caesar Rodney School District 2006 Analytics RaMP Reading Proficiency Male (%) B4.8] =
‘:r‘nr’\ﬂr\’;r‘nDEi 7-2|:|T:|_E.'Iﬁ- e Y ST B O - e T f...n‘.(m\ an e -

6. For the question “Where is the data that you want to analyze?” click “Microsoft Excel
list or database. For the question “What kind of report do you want to create?” select

“PivotTable”.

PivotTable and PivotChart Wizard - Step 1 of 3

‘where is the data that you want ko analyze?

* Microsoft Excel list or database:

" External data source
" Multiple consolidation ranges
~

‘what kind of report do vou want ko create?
% PivotTable
" PivotChart {with PivotTable)

Cancel

| Mext = |

Finish

7. Click Next to proceed.

8. The wizard will pre-populate the data you selected.

PivotTable and PivotChart Wizard - Step 2 of 3

EIX

‘Where is the data that you wank ko use?

Rangs:

Browse. ..

Einish |

< Back, | Mext = |

Cancel

9. Click Next to proceed.
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10. Select “New Worksheet” as where you want to put the PivotTable.

PivotTable and PivotChart Wizard - Step 3 of 3

“Where do wou want ta put the PivatTable?
% Mew workshest
" Existing worksheet

Click Finish to create your PivotTable.

Cancel ‘ < Back, i Fini

Lavout... | Options. .. ‘

11. Click Finish.

12. Excel will create a PivotTable for you. You will have to drag and drop the elements in

the field list to rotate the data.

A | B | ¢ | b | E [ F [ &

e [ v 0 Tk L T M [ n [ o ]

Drop Page Fields Here

Drop Colurnn Fields Here

PivotTable Field List v X

‘m|m‘w‘m|m‘n [FIINIES

o

Drop Data Items Here

Ix]
a1aH spleid moy doig

Drag ikems to the PivotTable report

= Code
SLEL

i ear

| Category
| Varisble
E|Dataz

e S R

=
)
=
Il
]
=)
54
=
(=)
m
1=
ny
=]
=]
(=1
By

[E3

< >

13. Drag and drop the indicator that you want to appear in rows into the “Drop Row

Fields Here" section (names).

A [ e [ ¢ [ o | E [ F [ &

[ n [ v [ o [ k [t [ M [ N [ o ]

Drop Page Fields Here

Crop Column Fields Here

PivotTable Field List - x

<

Drag items to the PivotTable report

g Marme:

|m|m‘\i‘m‘m|n W=

o

Drop Data ltems Here

)

@

=

alaH splai4 Moy doug

o

[ ear
[ Category
[ wariable
[ Dataz

EB

@

o

rara{ra
r|=|a

rafr
G

ool ra|mafro|ralra
r| = |O|@|m|=| 5| ¢

w
B

b
g

-
-
©
=
2
2
3
[
-
(=]
m
1=}
&
'
=1
[=]
5
e

%

< >
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14. Drag and drop the indicator that you want to appear in columns into the “Drop
Column Fields Here” section (variables).

15.

A 8 [ ¢ [ 0 [ E [ F | & [0 [k [ L [ M3
1 Drop Pane Fislds Here | =
2
3 o B Drop Colu mn FleldS Here- PivotTable Field List - x
5 [Appogumimink School Distict ¥<] Drag items to the PivotTable report
| B |Brandywine School District ] Code
| 7 |Caesar Rodney School District F{Name
& |Cape Henlopen School District
ECapnal School District B vear
| 10 |Christina Schoal District N Eleategor
| 11 |Colonial Schoal District Drop Data |tem8 Here
| 12 |Delmar School District [£| Dataz
| 13 |Indian River School District
| 14 |Lake Forest School District
| 16 [Laurel Schoal District
| 16 [Milford Schoal District
| 17 |Red Clay Consolidated School District
| 18 |Seaford School District
| 19 [Smyrna Schaol District
20 Woodbridge School District
21 |Grand Total
22|
F
B
25|
2|
Ed
El
EEl
En
Edl
E =
35
Ea -
W 4 » »lSheetl DE Dis 2006 / |< 3l

D

rag and drop the data field into the “Drop Data Items Here” section.

A

B | C | b] |

F | G \ ]

~
Drop Page Firn=

&

“Yariable m

Mame

[«

RalP Reading ProlRalMP Reading Prol RalP Reading Prol RabP Reading Proi RalP Reading Prol RalP Reading ProlRaMP R

Appoguinimink School District
Brandywine School District
Caesar Rodney School District
Cape Henlopen Schoal District
Capital School District
Christina School District
Colonial School District
Delmar School District

Indian River School District
Lake Forest School District
Laurel School District

Milford School District

Red Clay Consolidated School District
Seaford School District
Smyrma School District

20 WWoodbridge School District

=)

21 |Grand Tatal

Drop Data Items Here

PivotTable Field List * x
Drag items to the PivotTable report

= Code
| Mame
] vear

Category
=]

W 4 » whSheetl  DE_Dis_2006 /

<

PN & variable ~

>
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16. You will now have a document with variables across the top and locations down the
side. The bottom row and right-most column will summarize the data. The top left-

most cell will show how the data are being summarized.

3 | Sum of Data2 “ariable [=]

RaMP Reading

RaMP Reading

RaMP Reading

RaMP Reading

Mame Proficiency Asian/Pl F'm?:ir:::f;?:ig(%) Proficiency EconDis | Proficiency Female | Proficiency Hispanic Pr;at:\iﬁ;
4 [] (%) (%) (%) (%)

| 5 |Appoguinimink School District 90.3 78 76.1 B89.7 845
| B |Brandywine School District 923 B3.8 B4 83.1 BB.7
| 7 |Caesar Rodney School District 93.2 79.3 79 89.8 68.8
| 8 |Cape Henlopen School District B8.3 75 B87.9 71
| 9 |Capital School District 75 69 B8.6 798 788
| 10 |Christina School District &67.5 646 64.8 786 66.9
| 11 |Colonial School District 942 716 719 836 80.6
| 12 |Delmar Schaol District B7.7 748 86.4

| 13 |Indian River School District 783 G629 90.7 65.5
| 14 |Lake Faorest School District B8.7 738 B85.6

| 15 |Laurel School District 59.2 B6.2 77

| 16 |Milford School District 7681 81.1 99.3 62.3
| 17 |Red Clay Consolidated School District 949 B6.6 67.9 B84.8 701
| 18 |Seaford School District B3.2 68.9 78.8 85.7
| 19 |Smyrna School District 79.2 78.2 56.6

20 |Woodbridge School District 716 728 B16 75
21 |Grand Total E27 4 1127 1 11668 1355 3 935 3

— = =

pivot table and select Field Settings.
P
3 |Sum of Data2 D ['/ariahle
hlaras P E ells... Reading
5 |Appoguinimink S PivatChart
B |Brandywine Scho
7 |Caesar Rodney S is] PivotTable wizard
8 |Cape Henlopen 5S¢ § | Refresh Data
9 |Capital School Di -
10 | Christina School =B
11 |Colanial School O) Select 3
| 12 | Delmar _SChDDI Di Group and Show Detal — »
13 |Indian River Scho
14 |Lake Forest Schol
15 |Laurel School Dis
16 [Milford Schoal Di B —
17 |Red Clay Consali S B oo
18 |Seaford Schoal D Show PivotTable Toolbar
19 | Smyma School D Hide Field List
20 [Woodbridge Scho TETITeT T

PivotTable Ld

Source field:

Dataz

Mame: |Average of DataZ

o]
Cancel
Summarize by

Hide

Mumber ...

In the “Summarize by” box, select the type of summary you want.

To change the way your data is summarized, right click the top left-most cell of the

Opkions ==
Count Mums
19. Select OK.
3 |Average of Data2 “ariable F]
RaMP Reading RaMP Reading RaMP Reading
Marne Proficiency Asian/Pl Pm?;?ﬂi R;?i:gw) Proficiency EconDis F,mﬁilh:f RF?md!}g %) Proficiency Hispanic Pr;il
4 & (%) g d (%) g i %)

| 5 |Appoguinimink School District 980.3 78 76.1 837 845
| 6 |Brandywine School District 92.3 B63.6 B4 831 66.7
| 7 |Caesar Rodney Schoal District 93.2 793 79 69.8 68.8
| & |Cape Henlopen School District B3.3 75 a78 il
| 9 |Capital School District 78 B3 68.6 798 9.8
| 10 |Christina Schoal District B87.5 B4.6 648 786 669
| 11 | Colonial School District 94.2 715 71.9 83.5 80.6
| 12 |Delmar School District B7.7 74.6 66.4

| 13 |Indian River Schoal District 78.3 829 90.7 855
| 14 |Lake Forest School District B3.7 738 855

| 15 |Laurel School District 59.2 66.2 77

| 16 |Milford School District 781 81.1 693 623
| 17 |Red Clay Consolidated School District 949 BB.& R7.9 8438 701
| 16 |Seaford School District B63.2 63.9 78.8 8.7
| 19 |Smyrna School District 792 792 68.8

20 |Woodbridge School District 716 728 816 Fi-]

21 |Grand Total 09.62857143 70.44375 72.925 64.70625 78.075

77
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